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1.1 GENERAL ISSUES (All Editions)

• For information about printing from your H/PC, see Help in Microsoft Windows CE Services.

• If your H/PC supports backlighting, you may have a Backlight tab in Control Panel Display. On some
H/PCs, the Advanced button may be disabled if the device does not support advanced features.

• If you are printing via a serial connection and you disconnect and reconnect your cable, there may be
strange characters that appear at the top of your print out. After disconnecting your cable, turn off your
printer before reconnecting to clear the printer buffer of any extraneous information.

GENERAL ISSUES (Japanese Edition Only)

• You can transfer a TTC font file to your H/PC \Windows\Fonts folder using Windows CE Services.
This will setup your TTC file for use in your H/PC applications. You cannot, however, transfer the
TTC file from a PC Storage Card directly to the \Windows\Fonts folder and access it in your H/PC
applications. The transfer must occur through Windows CE Services.

• To use the following PHS adapter (PIAFS) cards, change the value for "Cancel the call if not
connected within" on the Call Option tab in Device Properties dialogbox to a value within the available
range below:

Name of PHS Adapter Card        Available Range
NTT Personal 32K PALDIO 321S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-1S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-2S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-1N 0 ~ 59
NTT Personal 32K PALDIO Data Card DC-2N 0 ~ 59



NTT Personal 32K PALDIO Data Card DC-1P 0 ~ 59
NTT Personal 32K PALDIO Data Card DC-2P 0 ~ 59
Panasonic TO-PHS32K 0 ~ 59

• If you use a non-Japanese font such as Tahoma and then switch to a Japanese character input method,
the font selection is not automatically changed to a Japanese font. When you use the IME to switch to a
Japanese character input method, you must manually change the font.

• A folder named "Storage Card" is displayed in romaji characters in the Windows Explorer when you
insert a memory card.

• You can transfer data via IR from a device running Windows CE v2.0 for the Handheld PC to a device
running Windows CE v1.0 for the Handheld PC. You cannot, however, open a bitmap file from a v2.0
H/PC on a v1.0 H/PC. In addition, you cannot open a file saved in Pocket Excel 2.0 in Pocket Excel
v1.0. You must first save the Pocket Excel 2.0 file as a 1.0 file and then transmit it via IR to the 1.0
H/PC.

_____________________________________________
1.2 MICROSOFT POCKET INTERNET EXPLORER (All Editions)

• Links to folders from a Web page are not supported.  To open the folder, type the link into the address
bar.

• The Back button doesn't go to the previous page if the link to the current page is in a frame. Instead,
the Back button goes to the page before the frame.  Links must be traversed again to get to the desired
page.

• To achieve best results when using the Set as Wallpaper option with a graphic image on a Web page;
do not use the Tile image on background option from Display Properties.  This affects grayscale
devices (both 4 and 16 shades of gray) only.

• If you save a bitmap to a file from Pocket Internet Explorer on a device that displays only four shades
of gray, the file cannot be properly converted when transferred to a desktop computer.

________________________________________________________________
1.3 MICROSOFT POCKET OUTLOOK(TM)

CALENDAR SYNCHRONIZATION (All Editions)

• See the "Synchronization" portion of the Microsoft Windows CE Services 2.1 section for any general
desktop synchronization issues.

CALENDAR (All Editions)

• When accepting group scheduling requests via Inbox, items that were sent as "private" will not appear
as private in Calendar.  After accepting such an item it will need to be manually edited to be marked as
"private" in the Calendar.

CALENDAR (US and European Editions)

• Devices that contain a MIPS processor will not allow you to enter any future appointments that begin
at 7:00 AM. You can workaround this problem by creating the appointment directly in Calendar view
or by changing the start time of the appointment to anything other than 7:00 AM, such as 6:59 AM or
7:01 AM.

CONTACTS (Japanese Edition Only)



• To use the Quickfind feature while sorting on either the "Name" or "Company" columns, type the
Yomi name (rather than literal name) in the Quickfind field.

• The Quickfind feature will work completely for any name as long as it does not contain a Kana
character using a dakuten or handakuten accent.  Quickfind is not able to distinguish properly between
a regular Kana character and one with the dakuten or handakuten accent.  At the point one of these
characters is used in a name, switch from using Quickfind to using the vertical scroll bar in contacts to
find the address card you are seeking.

INBOX (All Editions)

• Restore from 1.0 backup: Linked messages are corrupted on restore. Recreate the same services using
the exact same name. Then use the Service/Clear command and refresh for the service to download
the messages again and restore the links.

• If you get an error when trying to send Internet Mail that says, in part, "There was an error specifying
your return address to the server," you can try (after making sure your return address is correct) to
either ask your ISP to turn off strict RFC821 checking, or send mail via Inbox Sync or Inbox Transfer
instead.

INBOX SYNCHRONIZATION (All Editions)

• Inbox Synchronization supports the following clients: Windows Messaging Client, Microsoft
Exchange, and Microsoft Outlook '97.  Microsoft Outlook Express is NOT supported at this time.

INBOX (Japanese Edition Only)

• If you limit the number of lines in a message that should be downloaded from your Internet Service
Provider (ISP), you will in most cases see "Message truncated after n lines" at the end of your
message. However, there are some ISP's that return 1 less line than asked for and as a result, Inbox
thinks the message is completely downloaded and you will not see this text at the end of your message.
This is a problem on the ISP's server.

• The maximum message size that Inbox supports is 32k. If a message you download is larger than this,
you will see the text "Message truncated after 31k" at the end of your message. If you use QP to
encode your message, the size of your message may increase dramatically and as a result, the chance
that your message will exceed 32k is much higher. The encoding is in the first part of the downloaded
message and since Inbox stops downloading at 32k, part or all of the message body may be truncated.
To workaround this problem, do not use QP to encode your message.

• When you download a copy of a full message, there may be a discrepancy between what the server
reports as the size of the message and what the downloaded message size is. This is due to the fact that
the message server reports the size in bytes and Inbox reports the size in characters.

________________________________________________________
1.4 MICROSOFT POCKET WORD (US and European Edition)

• The online Help for how to use templates is incorrect. Template samples are located in the My
Handheld PC\Programs\Office\Templates folder. To create a template, save a file as a Pocket Word
template in this folder. To use a template, tap New on the File menu, and then tap Document From
Template.

• You cannot open Pocket Word 2.0 files that contain pictures in Pocket Word 1.0.

MICROSOFT POCKET WORD (Japanese Edition Only)



• In the Font, Ink, Drawing dialog box, you can set character and drawing format attributes. The Font
Name, Size, and Style options apply to text you input with the keyboard or SIP. The Pen Weight, Line
Color and Style options apply to text you write on your screen. The Fill Color option is only used for
drawings.

• When you set your Pen Weight to Bold or Thick in the Font, Ink, Drawings dialog, the Bold option
under styles is also selected.

• Pocket Word prints with a fixed font size and line height. As a result, the printed output will not appear
exactly as it does on your screen.

CONVERSION TO/FROM POCKET WORD (All Editions)

• The Pocket Word conversion process uses other converters installed by Microsoft Office. If you
receive an error message during file conversion indicating that a particular converter cannot be found,
rerun Microsoft Office Setup on the desktop and turn on all filter options.

• When you convert a Pocket Word file on your H/PC to an HTML file on your desktop computer, the
pictures in the Pocket Word file may be lost. This is due to a problem in one of the converters supplied
by Microsoft Office. This problem is addressed in the Microsoft Office 97 service release (SR-1),
which you can download from http://www.microsoft.com/office.

• When you convert a file from Pocket Word to Microsoft Word .doc or .rtf format, lists that contain
multiple styles of numbering (for example, where the first line is a number, second is a bullet, and third
is a letter) may be formatted with a single style of numbering.

• Clipart objects are not retained when converting from Microsoft Word to Pocket Word. To work
around this problem, you can convert your clipart objects to bitmaps by selecting the bitmap, copying
it, and then paste it as a bitmap using the Paste Special command in Microsoft Word. All objects will
then convert without a problem.

CONVERSION TO/FROM POCKET WORD (Japanese Edition)

• You can apply different font styles to bullets in Microsoft Word 97. If you use a font that is not
available on your H/PC and then convert a document containing bullets to Pocket Word format, you
may get unexpected characters in place of the bullets. You can workaround this problem by using the
Symbol font for your bullets or by copying the True Type font (files with a TTF extension) you used to
the \Windows\Fonts folder on your H/PC.

________________________________________________________________
1.5 MICROSOFT POCKET EXCEL (All Editions)

• Many operations in Pocket Excel, such as sorting, applying formatting, or applying an Autofilter, are
quicker if you select the specific range rather than entire columns, rows, or the entire worksheet.

• The online Help information about using templates is incorrect. Template samples are located in the
My Handheld PC\Programs\Office\Templates folder. To create a template, save a file as a Pocket
Excel template in this folder. To use a template, tap New on the File menu, and then tap Document
From Template.

• Omitting the second argument in DCOUNT and DCOUNTA results in an error value. To work around
this problem, you can use the cell reference containing one of the headings of your database. This will
behave the same as if you omit the second argument.



• If printing a worksheet fails and results in an error message, close your file and reopen it before
printing again. Otherwise, depending on the complexity of the file, the available memory on your
H/PC may be reduced.

• When you undo an action that you performed on a large number of cells, such as a sort, a slowdown
may occur. Close and reopen the file to work around the problem.

• Inserting, deleting, or moving a sheet within a workbook may cause the AutoFilter arrow buttons to
disappear. To make them reappear, reapply the AutoFilter.

• AutoFilter activation is not saved with your workbooks.

• Adding a custom number format results in additional custom number formats that appear as
unrecognized characters (blank squares). The additional formats are usable UNICODE format strings
for formats such as Chinese dates. These special formats aren't displayed until the user explicitly puts
in a custom format.

• Fractions are not always displayed correctly. Pocket Excel does not correctly limit the digits displayed
in the fraction. The underlying value, however, is correct and can be safely used in calculations. For
example, if you enter 1 5/12 in a cell, Pocket Excel displays it as 1 5/1; however, the underlying value
is 1 5/12.

• Border formatting is shown only in the Format Cells dialog box for the cells you specifically
formatted. Even though adjacent cells may appear to have border formatting in your worksheet, this is
not reflected on the Border tab in the Format Cells dialog box.

• Pocket Excel implements minimal support for local defined names in order to be compatible with
Microsoft Excel 95 and 97. If you must use local names, you should avoid creating duplicate local and
global names.

CONVERSION TO/FROM POCKET EXCEL (All Editions)

• The Microsoft Excel feature that enables you to change the currency symbol in the Format Cells dialog
box is not supported in Pocket Excel. Pocket Excel is unable to save files that use this feature.

• Microsoft Excel 97 supports 65536 rows. Pocket Excel supports 16384 rows. Rows beyond this are
deleted upon conversion from Excel 97 to Pocket Excel.

• Column formatting may be lost during conversion where it intersects with formatting applied to an
entire row. For example, if you have a row with a nondefault height and all other attributes are
defaults, column formatting information, such as borders, will be lost where the column(s) and row(s)
intersect when converting from Microsoft Excel to Pocket Excel. If you reapply the formatting in
Pocket Excel, the formatting will not subsequently be lost in the conversion process again.

• When you convert a file from Microsoft Excel to Pocket Excel, AutoFilter activation is not retained.
However, if your AutoFilter activation resulted in some rows being hidden, these rows are also hidden
in Pocket Excel. To display the rows, unhide them in Pocket Excel.

• Microsoft Excel 97 provides a new conditional number formatting feature. Cells formatted using this
feature may not be displayed properly.

• When converting a file that is formatted with color fonts, fills, or borders from Pocket Excel to
Microsoft Excel 95, some colors may not convert appropriately. All colors convert properly when
converting to Microsoft Excel 97.



• When converting from Pocket Excel to Microsoft Excel, many formats are added to the Custom
category in the Format Cells dialog box in Microsoft Excel on your desktop computer. Pocket Excel
displays all number formats it supports.

________________________________________________________________
1.6 MICROSOFT POCKET POWERPOINT (All Editions)

• Pocket PowerPoint(R) can require a lot of memory to display complex graphics. You may need to
allocate more RAM to Program Memory using System Control Panel.

• Pocket PowerPoint uses a caching scheme to improve performance when navigating forward and back
through a presentation. To minimize delays when advancing slides during a show, it is recommended
that you spend at least 5-10 seconds on each slide before advancing to the next. This will allow the
next slide image to be cached and ensure a quick transition. The size of the cache is directly related to
the availability of Program Memory. Also, this cache is automatically flushed if another program
requests additional memory.

• To display a presentation on an external monitor, your device must have a VGA port or a compatible
VGA PC Card.

• You cannot apply a font size to your title slide greater than 645.

CONVERSION TO POCKET POWERPOINT (All Editions)

• The Pocket PowerPoint conversion process uses PowerPoint 97 for file conversion. If you receive an
error message during file conversion indicating that a particular converter cannot be found, rerun
Microsoft Office Setup on the desktop and turn on all graphic filter options.

• During conversion a number of temporary files will be created in your desktop computers
\Windows\Temp folder. Under certain conditions, these temporary files may not be automatically
deleted, and you may need to manually delete them from time to time.

• "Compact" style file conversion notes: 1) Check your presentation carefully after conversion. If the
presentation file uses fonts not installed on your H/PC, you may encounter text wrapping and layout
problems. These can best be avoided by using an H/PC installed font or copying the additional fonts to
your H/PC's \Windows folder. 2) For best results, it is recommended that all text in the original
presentation be formatted with line spacing set to 1 and space between paragraphs set to 0. 4) Slide
background images are copied from the Master and Title Master Slides and used for all slides in the
presentation. If a particular slide uses a custom background, it will be lost during the conversion, and
the Master Slide background will be used instead.

• Avoid using animations and gradient fills in PowerPoint 97 presentations that you plan to convert to
Pocket PowerPoint. The animation may be partially depicted in the slide image and the gradient fills
may appear different than they would on a PC with more available colors and higher resolution.

________________________________________________________________
1.7 COMPATIBILITY WITH VERSION 1.0 PROGRAMS (All Editions)

The following issues have been observed when running existing H/PC 1.0 programs on H/PC 2.0
computers.

FONT DISPLAY

Programs that you used on Windows CE 1.0 for the H/PC are usable and functional on version 2.0.
However, demand for improved clarity and readability on H/PCs caused two major changes that have had



an impact on how 1.0 programs and dialog boxes are displayed:

1. The system font has been changed to Tahoma 9 pt.
2. The font technology used is now TrueType, which provides programs much more flexibility and

enables enhancements such as zooming.

To ensure compatibility and proper display of 1.0 programs on the H/PC 2.0, every effort has been made to
map fonts used in 1.0 program user interfaces to the closest matching font in terms of size and style
available on the H/PC 2.0. Due to this mapping, your 1.0 programs are displayed with a smaller menu font
and a smaller dialog box font than H/PC 2.0 programs. Still, because the fonts are being mapped to a font
that is similar though not identical to the 1.0 fonts, you may see one or more of the following issues in your
1.0 programs:

• Words at the end of option names in dialog boxes are clipped or missing due to the string being
slightly wider.

• The Close button (in the upper-right corner of the program window) is clipped due to the menu names
being slightly wider.

• Button names are not bold.

• In a few cases, the font in your program's main window is mapped to a smaller or larger font than that
displayed in 1.0.

Finally, due to the change to TrueType font technology, any program that provides a font dialog box in
which you can select a font name and size needs to be updated to provide a list of sizes. If the font dialog
box allows you to specify the size of the font by typing it, you can specify whatever size you need, and the
font will be displayed correctly due to the scalability of TrueType fonts. If you cannot type the font size,
one point size is provided for you.

TASKBAR

In Windows CE 2.0, you can set your taskbar to autohide. This allows you to take advantage of the screen
space occupied by the taskbar. Some 1.0 programs perform actions that prevent Windows CE from resizing
the program window appropriately. Therefore, when the taskbar is first set to autohide, the active program
does not appear to be resized to take advantage of the whole screen. Or when the autohide attribute is
turned off, the active program does not resize to accommodate the taskbar. The workaround is to exit and
restart the program (however, this workaround does not always correct the problems with some version 1.0
programs).

SPECIFIC PROGRAMS (US and European Editions)

Following are known issues regarding specific programs. The manufacturers of these products have been
contacted, and questions regarding the availability of updated software should be directed to the
manufacturer.

• Microsoft PowerToys 1.0, Pocket Internet Explorer 1.1, and H/PC Converter Utility 1.0 PowerToys
1.0 and Pocket Internet Explorer 1.1 are not compatible with Windows CE 2.0 for the H/PC. In
addition, the H/PC Converter Utility 1.0 is not compatible with Windows CE Services 2.1.  Please do
not install these programs on this release.  PowerToys 1.0 will be updated in the future, and Pocket
Internet Explorer 1.1 is now replaced by Pocket Internet Explorer 2.0,which is included in Windows
CE 2.0 for the H/PC. Microsoft is currently considering updating the H/PC Converter Utility.

• ART smARTwriter v1.0
When starting smARTwriter, an internal error is reported. After installing, you can use the inking



capability of smARTwriter in Pocket Word. However, the handwriting recognition does not work in
Windows CE 2.0. Please contact ART about an update for Windows CE 2.0.

• ART smARTwriter v1.0: InkPad
The leftmost character cannot be selected unless you double-tap the character or use the keyboard.
Tapping and dragging will not select the character. Please contact ART about an update for Windows
CE 2.0.

• Freeware: Pocket Dial4Me v1.0
The application cannot be minimized by pressing the taskbar button or by pressing the Desktop button
on the right side of the taskbar. You must close Pocket Dial4Me after using it. In addition, this
program is unable to load the Contacts database because it assumes a particular sort order for the
database, and this sort order has changed.

• Freeware: Pocket Dial v1.0
The application cannot be started under Windows CE 2.0 for the H/PC. Check
http://www.windowsce.com for update plans.

• CIC: Jot v1.0
On some H/PC's, Jot's inking and handwriting recognition may be slower than it was on 1.0 devices.
Please contact CIC about an update for Windows CE 2.0.

If you are using v1.0 on an H/PC with a wide screen, such as the Hewlett Packard Palmtop PC, lines
will appear to the right of where you touch the screen. This issue is fixed in Jot 1.02.

When ink disappears (that is, when it's converted to text), it can leave a gray or white trail depending
on what you inked over.

Some dialog text runs off the side of dialogs.

• CIC: QuickNotes v1.0
The background color in the thumbnail view is different from the color in the main window. In
addition, the eraser changes the background to white rather than the original color. Please contact CIC
about an update for Windows CE 2.0.

• Shareware: JimmyNotePad v1.0
The Symbol font is listed as an option in the Font dialog box. However, anything you format with the
Symbol font will be displayed in Arial.

• Shareware: JimmySoft Calendar Search v1.0
The search completes correctly, but all items show "Error: No date" in the Date/Time column.

• Landware: TakeNote v1.0
Interaction between TakeNote and the Pocket Outlook Contacts database does not work. You cannot
add a new entry to the Contacts database by using New Contact , nor can the Contacts database be
started from the New Phone form. In addition, in a new Ink Note, if you tap the Information (I) button,
the date appears with block characters. Please contact Landware about an update for Windows CE 2.0.

• Shareware: MG Notes v1.0
The Symbol font is listed as an option in the Font dialog box. However, anything you format with the
Symbol font will be displayed in Arial.

• Odyssey: Pocket OnSchedule v1.0
Pocket Internet Explorer cannot be started using the Contacts  Visit Web Site command. You must
instead copy the Web site URL, start Pocket Internet Explorer from the desktop, and paste it in the



Address box. Please contact Odyssey about an update for Windows CE 2.0.

Dialing options are not available in the Options dialog box.

Default items are not available in the Manage User Lists dialog box. Note that this problem only
occurs on H/PCs with an SH3 processor (such as Hewlett Packard Palmtop PC and Casio A-10, A-11).

• Physix: Pocket Chart v1.0
The list box on the command bar extends off the right side of the screen. You can still tap the box to
display the list. Please contact Physix about an update for Windows CE 2.0.

You can install Pocket Chart only to internal memory on the H/PC. You cannot install it to a PC Flash
or SRAM Card.

Some characters may be displayed as boxes (unrecognized characters) in the user interface.

Due to the complex nature of its layout, Pocket Chart exhibits several of the text issues detailed in
"Font Display" in this section.

• Ruksun: Telnet Force v1.0
When the taskbar is hidden, Telnet Force is displayed in full screen mode. This causes the contents of
any Telnet site to be displayed in a font that is unreadable because it is so small. To work around the
problem, clear the AutoHide option and then start Telnet Force. Ruksun is investigating this issue.
Please contact Ruksun about an update for Windows CE 2.0.

On wide displays, such as the Hewlett Packard Palmtop PC, no scroll bar is displayed. There are some
cases in which the text in the window is scrolled to the left of the screen so that the left edge is not
visible. When this occurs, the text to the left of the screen cannot be accessed due to the absence of a
scroll bar.

• Shareware: Invaders v1.0
This program cannot be started on Windows CE 2.0 for the H/PC.

• SkyTel: Messenger v1.0
Messages are delivered with square boxes (unrecognized characters) in place of carriage returns.
Please contact SkyTel about an update for Windows CE 2.0.

• SpryNet: Sprynet v1.0
After setting up the SpryNet transport in Inbox, you must reset the password you specified when
setting up the transport. You can do this by going to step 1 of the Internet Mail service properties and
retyping your password. Please contact Sprynet about an update for Windows CE 2.0.

• Symantec: PC Anywhere v1.0
PC Anywhere While connected to your PC, dragging icons on your PC desktop results in black trails
being drawn on your H/PC screen. Symantec is investigating this issue. Please contact Symantec about
an update for Windows CE 2.0.

• Wynd Communications: WyndMail v1.0
If you want to change properties after installing the WyndMail transport, open Inbox, tap Service,
ensure WyndMail is selected, and then tap Properties. If you access the Properties dialog box by
tapping Compose and then tapping Options, the dialog box title is cut off; consequently, you cannot
move the dialog box or tap the OK or Cancel button. Please contact Wynd Communications about an
update for Windows CE 2.0.

• Dataviz: Desktop To Go v1.0



If you install Desktop To Go after installing Windows CE Services, the filters are not available in the
Tools  File Conversion dialog box. You must reinstall Windows CE Services after installing Desktop
To Go for the filters to appear in the File Conversion dialog box. Please contact Dataviz about an
update for Windows CE 2.0.

• Wright Strategies: FormLogic v1.0
After completing the desktop installation of FormLogic, use a command in the main program on the
PC to initiate installation to your H/PC. This command is not available with Windows CE Services
installed. Contact Wright Strategies for an update. Please contact Wright Strategies about an update for
Windows CE 2.0.

SPECIFIC PROGRAMS (Japanese Edition)
Every effort has been made to ensure that v1,.0 applications designed for Windows CE v1.01 for the
H/PC (Japanese Edition) will work on Windows CE v2.0 for the H/PC (Japanese Edition). If you see
any problems with your v1.0 applications, please report them to your software vendor and inquire
about updates for Windows CE v2.0 for the H/PC.

________________________________________________________________
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________________________________________________________________
2.1 GENERAL

• If device performance becomes poor over time, or if you notice odd behavior, reset your device to
restore normal behavior. Instructions for resetting your Palm PC can be found in the manufacturer's
instruction manual.

• Since Mobile Channel content contains formatting information, and not just text, strange characters
may appear when Find locates Mobile Channel content. This is normal, and the data will be displayed
correctly in the Channels application.

________________________________________________________________
2.2 ACTIVE DESKTOP

• If a component on the Active Desktop is not refreshing properly, go to Settings > Display, uncheck
the component, check it again, and tap OK. This will cause all Active Desktop components to reload,
clearing any such problems.

________________________________________________________________
2.3 CHANNELS

• If you receive "Out of memory" messages on your desktop computer during channel synchronization,
do the following. First, switch to Channels, go to View > Options, and tap OK without changing
anything in the dialog box. This will make sure that the maximum storage limit is the full percentage
shown in this dialog, instead of a fixed 200KB limit imposed the first time the device is turned on, as
well as after a full reset (cold boot). If, after opening the dialog box and tapping OK you still receive
frequent "Out of memory" messages, switch to Channels, go to View > Options, increase the % of



storage memory value, and tap OK.

• If you see sync initialization error 8007000e when trying to enable channel synchronization, you do
not have Internet Explorer version 4.0 or later installed on your desktop computer. To synchronize
channels, you must be running Microsoft Internet Explorer 4.0 or later on your desktop computer. You
can install Internet Explorer 4.0 from optional components on the Desktop Software for Windows CE
compact disc.

________________________________________________________________
2.4 MICROSOFT POCKET OUTLOOK

• See the "Synchronization" section of the Microsoft Windows CE Services 2.1 section for any general
desktop synchronization issues.

• Synchronization will copy text (not ink) notes only between the device and Schedule+ 7.0. Because
Schedule+ does not support ink annotations in notes, these annotations will not be synchronized
between the device and Schedule+, and changing a note in Schedule+ will remove the ink annotation
on the device the next time the object is synchronized. Ink notes are synchronized with Microsoft
Outlook except when they are contained in an appointment that is an exception to a recurring
appointment.

MEETING REQUESTS

• If you wish to send meeting requests over a transport other than Window CE Inbox Services, in
calendar, tap Tools > Options and select the new transport. For example, if you set up a POP3 e-mail
transport and want to use it for sending both meeting requests and e-mail, you must set the transport in
Calendar as well as in Inbox.

INBOX

• Meeting requests and attachments are downloaded via the Internet Email transport only if you select
the applicable option in the Service Properties dialog box, step 3. Note that these options are not
turned on by default. In addition, due to limitations of POP3, you must download a full copy of the
message. Note that you can use Service > Retrieve Full Copy if you initially limit the number of
lines.

• If you are accessing your e-mail via Microsoft Exchange POP3 server support and you send and
receive meeting requests, have your mail administrator select the Download Microsoft Rich Text
check box on the POP3 protocol page. This is required to receive meeting requests, but it will slow
down mail transfer because more data is sent from the server for each message.

• Note that messages in your Inbox that came from Internet Mail or Inbox Sync are linked to those on
the server, and deleting them on your device will delete them on the server.

• If you get an error when trying to send Internet Mail that says, in part, "There was an error specifying
your return address to the server," you can try (after making sure your return address is correct) to
either ask your ISP to turn off strict RFC821 checking, or send mail via Inbox Sync or Inbox Transfer
instead.

• Embedded OLE attachments and e-mail messages are not preserved in messages. Only file attachments
are preserved.

INBOX SYNCHRONIZATION



• Message synchronization: you will receive duplicate messages if you are using Message Sync and the
Internet Mail service to connect to the same mail server. To avoid this, it is recommended that you use
Remote ActiveSync, rather than Internet Mail, to retrieve e-mail when using Remote Networking.

• Deleting messages from your Inbox on your desktop computer or device while you are synchronizing
can sometimes cause messages to become "stuck" in your Deleted Items folder. If your
synchronization status reports one or more items out of date despite repeated efforts to synchronize,
follow these steps to correct the problem:

1. On the device, move the items from the Deleted Items folder to the Inbox folder.
2. On the device, create a new folder.
3. On the device, move the items that you undeleted in Step 1 from the Inbox folder to the new

folder.
4. Synchronize the device with the desktop PC.

________________________________________________________________
2.5 NOTE TAKER

• Removing a storage card with a note open can cause data loss. Do not remove a storage card when a
note stored on this card is currently open.

• The Note Taker application main window list view does not refresh automatically when adding and/or
removing notes using the Mobile Devices folder on the desktop. To refresh your file list, switch to a
different application on the Palm PC and back to Note Taker.

• To distinguish between a template saved on a storage card and one saved in storage (main) memory,
look for an asterisk at the end of the template's name. Any template with an asterisk at the end of the
name is saved on a storage card.

________________________________________________________________
2.6 VOICE RECORDER

• The Desktop Mobile Voice CODEC does not convert to PCM format if the voice recording is less than
two seconds in duration. For example, if you have a voice recording that you wish to send to someone
who does not have the Mobile Voice CODEC installed on their desktop machine, make sure that the
recording is more than 2 seconds in duration before converting it to PCM.

• The Voice Recorder application main window list view does not refresh automatically when adding
and/or removing notes using the Mobile Devices folder on the desktop. To refresh your file list, switch
to a different application on the Palm PC and back to Voice Recorder.

• Running processor-intensive applications may interfere with recording. This includes functionality
such as a modem, such that on most devices, you will not be able to record while using the modem.

________________________________________________________________
2.7 MICROSOFT POCKET POWERPOINT

• The Pocket PowerPoint component provided in the Optional Components directory of the Windows
CE Services compact disc or on floppy disk is not compatible with Palm PC devices.

________________________________________________________________
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________________________________________________________________
3.1 INSTALLING WINDOWS CE SERVICES

To begin installation, insert the CD-ROM into your CD-ROM drive.  The Setup program will automatically
be run from the CD-ROM. If it does not start automatically, click Start, click Run, and type d:\Setup,
where d: is the drive letter of your CD-ROM drive.

After starting Setup, the Microsoft Windows CE Services Setup window is displayed if you already have
Schedule+ 7.0a or Outlook installed on your desktop computer.  Click Next to proceed with Setup.  If you
do not have Schedule+ 7.0a or Outlook installed on your system, the Microsoft Windows CE Services CD-
ROM main Setup window is displayed.

On Windows 95 systems, the main Setup window will provide you with four buttons on the right side of
the screen, labeled:

1. Install Microsoft Exchange Update for Windows 95
2. Install Microsoft Schedule+ 7.0a
3. Install Microsoft Windows CE Services
4. Optional Components

On Windows NT(R) systems, the main Setup window will provide you with three buttons on the right side
of the screen, labeled:

1. Install Microsoft Schedule+ 7.0a
2. Install Microsoft Windows CE Services
3. Optional Components

Click each of these buttons in this order. If your desktop computer does not need to install a component, the
message "Already installed or not required" is displayed below that component. If you do need the
component, installation will automatically begin once you click the button. Follow the instructions to
complete the installation of each component.

NOTE: During setup, you may be asked to reboot your desktop computer. After your computer finishes
rebooting, reinsert the CD-ROM and continue with the remaining Setup components.

3.2 WINDOWS CE SERVICES SETUP ERRORS

• If you encounter any errors during Windows CE Services Setup, Windows CE Services Help can assist
you in finding the solution to the problem.  To use Windows CE Services Help, open the Mobile
Devices folder by double-clicking the My Computer icon on your desktop and then double-clicking the
Mobile Devices icon.  From the Mobile Devices window, click Communications Troubleshooter on
the Help menu.  You can also access Help by clicking Start, Programs, Windows CE Services, and
then Help.  The Communications Troubleshooter Help topic provides assistance for most commonly
encountered setup and connection problems.  The General Tips section at the bottom of this topic
provides additional assistance for less frequent problems.

• If you cannot start Windows CE Services, reinstall Windows CE Services by  following the steps in the



Installing Windows CE Services section of this file.

• When replacing Mapi32.during Windows CE Services setup, you may be warned that the currently
installed Mapi32.dll will be replaced with an earlier version. If you see this message, keep the newer
version of Mapi32.dll.

If you do not have the newer version of Mapi32.dll, you may have difficulty using Schedule+ for group
scheduling. If you are having problems with group scheduling, and if you did not keep the newer version of
MAPI32.DLL during setup, you need to reinstall the Microsoft Exchange Update. Instructions for doing so
can be found in the Removing or Reinstalling Schedule+ or Microsoft Exchange Update section of this file.

NOTE: Reinstalling the Microsoft Exchange Update may lead to the "Reg32.cfg" problem described in the
Synchronization section. If it does, reinstall Schedule+ 7.0a after reinstalling the Microsoft Exchange
Update to fix the problem.

3.3 OPTIONAL COMPONENTS

• The Optional Components directory on your installation CD contains several additional components
that may be of interest to you.  For example, the Windows 95 Dial-Up Networking Upgrade can be
installed if you need to support direct modem connections to your desktop computer from your mobile
device.  The Windows 95 Infrared Support directory contains software to support infrared connectivity
on your desktop computer.  Consult the Readme or Release Note information in each Optional
Component directory for details on the features and issues of each component.

• Microsoft Windows 95 Infrared Support Software
If you install Windows CE Services via a network connection to a shared CD-ROM drive and choose
to install the Windows 95 Infrared Support software contained in Optional Components, Setup will
alert you that the file Infrared.inf could not be opened. The workaround is to copy the Microsoft
Windows 95 Infrared Support Software directory to your hard drive and install it from there.  NOTE:
Infrared support for Windows NT is not available.

• Microsoft Windows 95 Dial-Up Networking Upgrade 1.2
If you are a Windows 95 user and want to establish an outbound dial-up networking connection (such
as a connection to your Internet service provider or corporate network) while device connections are
enabled on your computer, or you want to use a modem connected to your desktop computer for
remote device connections, you may need to install the Dial-Up Networking Upgrade 1.2 from the
Optional Components directory of your installation CD-ROM.  Please read the Readme file in that
directory for more information on the features and issues of this upgrade.

You should read the Dial-Up Networking 1.2 Release Notes.doc and About PPTP and Dial-Up
Networking 1.2.doc files that are placed in the \Windows directory after installing the dial-up
networking software. Certain software may need to be reinstalled after upgrading dial-up networking,
and these documents describe the issues in greater detail.

If you install the Dial-Up Networking 1.2 Upgrade and lose network connectivity, perform the
following steps to correct the problem.

1. In the Network Control Panel, double-click TCP/IP -> Dial-Up Adapter.
2. Click the Bindings tab.
3. Select Client for Microsoft Networks.
4. Click OK to all dialog boxes.

• Microsoft Internet Explorer 4.0 (Palm PC only)
The Mobile Channels feature on your Palm PC requires Internet Explorer 4.0 or later with Active
Desktop to perform Channel synchronization with your desktop system.  If you do not already have
Internet Explorer 4.0 installed on your system, you should install it by running Ie4setup.exe from the



Optional Components directory on your Windows CE Services CD before enabling Mobile Channel
Synchronization.  See the Internet Explorer 4.0 Issues section below for additional issues related to this
component.

• Microsoft Windows NT Service Pack 3
The Service Pack 3 must be installed on Windows NT systems in some cases after installation of
Windows CE Services and also before installing Microsoft Internet Explorer 4.0 or later.  The 40-bit
encryption version of this component is provided in the Optional Components directory of the
Windows CE Services CD.  Install this component by running Update.exe located in the \I386
directory within the Microsoft Windows NT Service Pack 3 folder in Optional Components.  See the
Internet Explorer 4.0 Issues and Windows NT Issues sections below for further information on this
component.

• Microsoft Pocket PowerPoint (Palm PC only)
The Pocket PowerPoint component provided in the Optional Components directory of the Windows
CE Services CD does not support operation on Palm PC devices.

3.4 SYNCHRONIZATION

• If an error message states that Schedule+ cannot open the file Req32.cfg, it is likely that you installed
the Microsoft Exchange Update after you installed Schedule+ 7.0a. To fix this problem, reinstall
Schedule+ 7.0a as described in this file.

• See the International Compatibility Issues section if you are using file synchronization between a
device and Windows CE Services that are not the same language or if you are having problems
synchronizing Japanese filenames on Windows NT systems.

• If you see sync initialization error 8007000e when trying to enable channel synchronization, you do
not have Internet Explorer 4.0 installed on your desktop computer.  See the Optional Components
section above for details on installing Internet Explorer 4.0.

• If you synchronize your device with Microsoft Outlook, and both Microsoft Outlook and your device
are set to a location in the southern hemisphere, appointments may be displayed at incorrect times.
This problem will not occur if you are using Microsoft Outlook version 8.03 or later.  Early versions of
the Handheld PC may require a device update to correct this problem.  Check with your device
manufacturer for availability of an update

3.5 INTERNET EXPLORER 4.0 ISSUES

• If you are having difficulty copying folders or browsing the Mobile Devices folder using Internet
Explorer 4.0, you should open the Mobile Devices folder using the shortcut on your desktop.  If the
problem persists, you may need to upgrade to a newer version of Internet Explorer when it becomes
available.

• If your Mobile Devices folder does not properly display current device status, you may need to select
Refresh on the View menu.

• If you install Internet Explorer 4.0 after you installed Windows CE Services, you will find that the
communications port you were using is reported to be "not available."  Restarting the computer will
solve this problem.

• If you are using Windows NT, you will need to install Windows CE Services, any previously installed
Service Pack, and Internet Explorer 4.0, in that order.

3.6 INTERNATIONAL COMPATIBILITY ISSUES



• Some Optional Components may not support operation on non-U.S. English versions of Windows.

World Wide English (WWE) CD version
• The WWE version of Microsoft Windows CE Services, Microsoft Schedule+ 7.0a, and Microsoft

Windows 95 Dial-Up Networking Upgrade 1.2 software can operate on Western European versions of
Microsoft Windows, but not on Japanese versions of Windows.

• WWE and Western European Windows CE based mobile devices can be connected to the WWE
version of Windows CE Services, but not Japanese version mobile devices.

• The English version of Microsoft Exchange Update can cause serious problems if installed on non-
U.S. English versions of Windows. Installing this update on any installation of Windows 95 other than
the U.S. English version is not recommended or supported.

• File synchronization cannot be automatically set up when you drag a file from your desktop computer
to a device of a different language from Windows CE Services.  To set up synchronization for a file on
the desktop computer, drag the file to the Synchronized Files folder in the My Documents directory on
the device.  If the Synchronize File dialog box appears, make sure that the No, just copy these files
option is selected, the Do not display this message in the future is selected and click OK.

Western European CD versions
• Western European versions of Microsoft Windows CE Services can operate on WWE versions of

Windows, but not on Japanese versions of Windows.

• WWE and Western European Windows CE based mobile devices can be connected to Western
European versions of Windows CE Services, but not Japanese version mobile devices.

• During Windows CE Services setup, the Network Control Panel may not be automatically dismissed.
When you click OK to dismiss it, you will be asked if you want to reboot your computer. Clicking Yes
may end Setup prematurely.

• File synchronization cannot be automatically set up when you drag a file from your desktop computer
to a device of a different language from Windows CE Services.  To set up synchronization for a file on
the desktop computer, drag the file to the Synchronized Files folder in the My Documents directory on
the device.  If the Synchronize File dialog box appears, make sure that the No, just copy these files
option is selected, the Do not display this message in the future is selected and click OK.

• If you are synchronizing to the Italian, Spanish or Brazilian Portuguese versions of Schedule+, you
will not be able to use the Windows CE Services provided 'Advanced' option to specify a specific .scd
file to synchronize to.  ActiveSync will synchronize to the Schedule+ file specified by the profile in
use at the time the partnership is created.  If you want to specify a specific Schedule+ file, you must
install the English version of Schedule+ or change the Schedule+ file specified by your Schedule+
profile.

Japanese CD version
• The Japanese version of Windows CE Services can only operate on a Japanese version of Windows.

• Only Japanese versions of Windows CE based mobile devices can connect to the Japanese version of
Windows CE Services.

• The following components are not provided on the Japanese version of the Desktop Software for
Windows CE CD:  Microsoft Schedule+, Microsoft Exchange Update, Microsoft Internet Explorer,
Microsoft Windows NT Service Pack 3, and Microsoft Windows 95 Dial-Up Networking Upgrade
version 1.2.



• File synchronization may not work properly on Windows NT systems for Japanese filenames
containing certain double-byte characters.  This problem can be corrected by installing Windows NT
Service Pack 3 onto your desktop computer system.  Contact the provider of your Windows NT system
software for availability of this update.

• If you are unable to successfully connect your device to the COM1 serial port on a Japanese version
Windows 95 system running on slower PC versions, try using the COM2 port.

3.7 CONNECTION

• Windows 95 Dial-up Networking (DUN) limits the number of inbound / outbound connections you can
have concurrently on your system.  Unless you have installed the DUN 1.2 Upgrade, you are limited to
one connection, so you will not be able to make an outbound modem connection if you have a mobile
device connected and vice versa.  With the DUN 1.2 Upgrade available on the Windows CE Services
CD, you can have two inbound / outbound connections, thus you can have a device connected and a
concurrent outbound modem connection.  Outbound Virtual Private Network (PPTP) connections
require two outbound dial-up connections, however, so you will not be able concurrently connect a
device and have a VPN connection.  Windows CE Services allocates an inbound dial-up serial port
when  serial connections are enabled.  You can quickly disable / enable serial connections from the
File menu in the Mobile Devices folder to free up this port allocation for other uses.

• Connecting a handheld device to your desktop if you have Internet auto-dial capability turned on may
cause the desktop to attempt a dial-up connection via your modem when you connect your mobile
device.  If this happens, open the Internet Control Panel, select the Connection tab and disable the Auto
Connect feature as follow.  If you are using Internet Explorer version 3.x, clear the checkbox next to
the "Connect to the Internet as needed" field.  If you are using Internet Explorer 4.x, select 'Connect to
the Internet using a local area network'.

• Users wanting to establish an outbound dial-up networking connection such as a connection to your
Internet service provider or corporate network while device connections are enabled on your computer,
or  wanting to use a modem connected to your desktop computer for remote device connections may
need to do the following:
• Windows 95:  You may need to install the Dial-Up Networking Upgrade 1.2.  See the Optional

Components section above for details.
• Windows 98:  You will need to add a second Dial-Up adapter.  From the Configuration panel of

the Network Control Panel, click Add.  Double-click Adapter in the Select Network Component
list box.  In the Manufacturers list box of the Select Network adapters dialog, select Microsoft,
Select Dial-Up Adapter in the Network Adapters listbox and click OK.  Repeat the steps above
and add the Microsoft Virtual Private Networking Adapter as well.  To add inbound modem
capability, select Communications in the Windows System panel of the Add/Remove Programs
Control Panel.  Click Details.  Select Dial-Up Server in the list box and click OK twice.

3.8 WINDOWS NT ISSUES AND TROUBLESHOOTING

• You must be running Windows NT version 4.0 with Networking installed. You cannot use this
software with a beta release of Windows NT 4.0 or Windows NT 3.51 or earlier.

• Dial-out modem connections not working after installation of Window CE Services

If you had multiple modems setup on the same serial port on your PC system for outbound dialing
prior to installing Windows CE Services, you will need to restore the modem setup after installing
Windows CE Services using the following steps.  Note, the serial port that you use for your outbound
modem connections must be different from the serial port you use to connect your mobile device.



1. Open the Network Control Panel, click the Services tab and double-click the Remote Access
Service entry in the list box.  Select the COM port in the list box that you want to have multiple
modems attached to.  One modem should already be attached to this COM port.

2. Click Add.  You will see the Add RAS Device dialog.  Select the next modem that you want
attached to this COM port from the list of RAS Capable Devices. Click OK.  Click Continue in
the Remote Access Setup dialog to complete the setup of your modem to this port.  Repeat this as
necessary for all unattached modems.

3. Click OK on the Network Control Panel dialog.

4. Restart your system.

• If you are using Point-to-Point Tunneling Protocol (PPTP) and are having difficulty connecting to your
desktop computer either shortly after another device has disconnected or after you have connected
using another connection method (such as switching from serial cable connect to Ethernet LAN
connect), you may need to reset your desktop computer.

If you continue to have problems, perform the following steps.

1. On the Start menu, click Run.
2. Type regedit, then click OK.
3. Select the HKEY_CURRENT_USER\Software\Microsoft\Windows CE Services registry key.
4. Select New and then DWORD Value on the Edit menu.  Type RasHardDisconnect to rename

the New Value entry.
5. Select the RasHardDisconnect registry value, then click Modify on the Edit menu.
6. Enter 1 in the Value data field, and click OK.
7. Exit the Registry Editor.

• If you have installed any of the Windows NT Service Packs and any Windows components were
installed during setup, you will need to reinstall the Service Pack.  You may not be able to connect
your device until you reinstall the Service Pack.  See the Optional Components section above for
further information on the Service Pack 3 provided on the Windows CE Services CD.

• See the International Issues section if you are having problems synchronizing Japanese filenames on
Windows NT systems.

• Connection Problems on Compaq 5xxx-Series LTE Laptops

On these computers, you may encounter a conflict between the IR port and the COM1 serial port that
disables communications with your mobile device. If you encounter problems connecting on one of
these laptops, try the following steps:

1. During the boot process, your laptop will display "F10 to enter Computer Setup." Press F10.
2. Go to Ports/Serial-Infrared Ports.
3. Switch the Infrared IRQ to 3.
4. Switch the Infrared address from 3e8 to 2e8.
5. Exit, saving any changes, and reboot.

• Networking Is Not Installed on Your Windows NT Computer

If your Windows NT computer does not have networking components installed, Windows CE Services
cannot communicate with your mobile device. To install these required components:

1. Click Start, Settings, and then Control Panel.
2. Double-click Network.



3. In the Network Configuration dialog box, click Yes.
4. In the Network Setup Wizard:

A. Verify that Wired to the network is selected.
B. Verify that Remote access to the network is not selected.
C. Click Next.

5. Click the Select from list button.
6. In the Select Network Adapter dialog box:

A. Find MS Loopback Adapter in the Network Adapter list.
B. Click OK.

7. In the Network Adapters list, verify that MS Loopback Adapter is selected, and click Next.
8. In the Network Protocols list, verify that only TCP/IP Protocol is selected (everything else is not

selected), and click Next.
9. Click Next again when you see the Network Services list.
10. Click Next to install the selected components.
11. In the Windows NT Setup dialog box, enter the directory where your NT source files are located

(e.g., D:\i386), and click Continue.
12. In MS Loopback Adapter Card Setup, accept the default Frame Type by clicking Continue.
13. In the TCP/IP Setup dialog box, click No when asked to use DHCP.
14. In the Microsoft TCP/IP Properties dialog box:

A In the IP Address tab, verify that MS Loopback Adapter is selected in the Adapter list.
B. Click the Specify an IP address option.
C. In the IP Address entry, type 1.1.1.1.
D. In the Subnet Mask entry, enter 0.255.255.255.
E. Leave the Default Gateway entry blank.
F. Click OK.

15. Click Next to pass the bindings dialog box.
16. Click Next when Windows NT Networking is ready to start the Network.
17. Click Next to accept all the defaults when asked for the Computer Name.
18. Click Finish to complete the Networking Wizard.
19. In Network Settings Change, click Yes to restart your computer.

After logging in to the Windows NT computer with a user account with Administrator privileges, run
Windows CE Services Setup to completion.

• Setup Could Not Be Completed
If you were unable to successfully complete Setup on your Windows NT system, you may need to
manually install Windows CE Services communications components using the following procedure.

On Windows NT 4.0 Systems

To install the required communications services on Windows NT 4.0:

1. In the Mobile Devices window, click Windows CE Services Help Topics on the Help menu.
2. Click the Find tab.
3. Under section 1, type troubleshooting.
4. Under section 3, double-click General Troubleshooting.

On Windows NT 5.0 Beta 1 Systems

The following steps have been verified on Windows NT 5.0 Beta 1, build 1671.  If you have a build other



than this and setup does not complete successfully after you perform the following steps, you will need to
install the 1671 build of Windows NT that has been verified.

Add the dial-up adapters:

5. On the Start menu, click Settings, and then click Control Panel.
6. Double-click Modems. (You may need to click Add if the wizard doesn't appear.)
7.  Select Don't detect my modem, I will select from a list.
8. Click Next.
9. In the Manufacturers list, select Standard modem types.
10.  In the Models list, select Dial-Up Networking Serial Cable between 2 PCs.
11.  Click Next.
12.  Click Selected ports.
13.  Select the COM port you will use to connect to your device.
14.  Click Next.
15.  Click Finish.
16.  Click Close to close the Modem Control Panel.

Add and configure the Dial-Up Server:

17. Double-click Network.
18. Select the Services tab.
19. Click Add.
20. Choose Dial-Up Server.
21. Click OK.
22. Select the Dial-Up Server.
23. Click Properties.
24. Clear Require data encryption.
25. Select the TCP/IP tab.
26. Click This computer only.
27. Click Use static address pool.
28. In the Address box, type 192.168.55.98.
29. Make sure Allow remote clients to request a predetermined IP address is cleared.
30. Click OK to close the Dial-Up Server properties.
31. Click the Bindings tab.
32. Under Show Bindings for, click All services.
33. Double-click Dial-Up Server to display the items bound to it.  The Dial-Up adapters may be

disabled as indicated by the red circle-slash symbol.
34. Select the Dial-Up adapter you will be using, and click Enable.  The red circle-slash should be

replaced by a picture of a PC adapter to indicate that the selected adapter is enabled.  If the red
circle-slash remains, you will need to disable the currently enabled adapter and try again.

35. Click OK to close the Network Control Panel.
36. Don't restart at this time.

Set the Windows NT RAS port entry in the registry:

37. On the Start menu, click Run.
38. Type regedit, then click OK.
39. Select the HKEY_CURRENT_USER\Software\Microsoft\Windows CE Services registry key.
40. In the selected registry key, locate the NT RAS Port registry value.
41. If this value does not exist, create it by clicking New and then String Value on the Edit menu.

Type NT RAS Port to rename the New Value entry.
42. Select the NT RAS Port registry value, and then click Modify on the Edit menu.
43. Enter the communications port that you will be connecting your device to in the Value data box

(COM1 for example), and then click OK.
44. Exit the Registry Editor.



45. Restart the computer to allow changes to take effect.
46. Connect using an account with dial-in permission.

IF YOU ARE STILL HAVING PROBLEMS:

Consult the Communications Troubleshooter in Windows CE Services Help by selecting Communications
Troubleshooter on the Mobile Devices window Help menu. This Help file directs you through a number
of diagnostic steps to identify and correct any problems.

Consult the Microsoft Windows CE home page for additional information and troubleshooting tips
(http://www.microsoft.com/windowsce/).

3.9 CREATING FLOPPY DISKS

If you do not have a CD-ROM drive on the PC where you want to install Windows CE Services, then
locate another computer with a CD-ROM drive and a 3.5" 1.44 MB floppy drive. Use the following steps to
create disks for floppy installation.

1. Obtain enough blank, formatted 3.5" 1.44MB floppy disks to hold the components you wish to install.
2. On the CD-ROM, open the Floppy directory.  The Floppy directory contains several component

folders, each containing one or more Disk folders.  You will create one floppy for each disk folder.
Label each floppy with the name of the component and the disk number.  For example, you will label
three floppies with "Windows CE Services Disk 1" to Disk 3.

3. On the CD-ROM, open the first component directory.  For example, open Windows CE Services.
4. Copy all of the files inside each of the Disk directories (for example, Disk1, Disk2, Disk3) to the

corresponding floppy disks you made in step 2.

NOTE: Do not copy the Disk1, Disk2, and Disk3 folders to the floppy disks; copy the files inside
these folders to the disks.

5. Repeat steps 3 and 4 for each component directory.

IMPORTANT: DO NOT PROCEED WITH INSTALLATION OF ANY OF THESE COMPONENTS
UNTIL YOU HAVE READ THE NEXT SECTION.

You have now copied all of the files necessary to complete the installation of Windows CE Services and all
other supporting components. Proceed to the next section of this file to install Windows CE Services from
floppy disks.

3.10 FLOPPY DISK INSTALLATION

You must perform required updates and install Microsoft Windows CE Services before you can transfer
files and synchronize data between your desktop computer and mobile device. Follow these steps to
complete the installation process. During installation, you will be asked to restart your computer. Before
you begin, save your work and quit all programs.

IMPORTANT: Do not start installation until you have read the entire installation instructions. Follow the
procedures in the order shown here. Installing programs out of order may cause problems.

Windows 95

1. If you have H/PC Explorer 1.x, remove it.
2. Update the Microsoft Exchange client, if required.
3. If you do not have Microsoft Outlook installed, install Microsoft Schedule+ 7.0a.
4. Install Windows CE Services (known as H/PC Explorer in version 1.x).
5. Install Microsoft Windows 95 Dial-Up Networking 1.2 Upgrade. This step is optional. If you installed



Windows 95 from a CD-ROM, you will need the Windows 95 CD-ROM to complete this upgrade.

Windows NT

1. If you have H/PC Explorer 1.x, remove it.
2. If you do not have Microsoft Outlook installed, install Microsoft Schedule+ 7.0a.
3. Install Windows CE Services (known as H/PC Explorer in version 1.x).
4. After you install Windows CE Services, you may see a message stating that you may not be able to

connect until you reinstall the Windows NT Service Pack. Before you reinstall the service pack, try
connecting your device to your desktop computer. If you cannot connect, install the service pack.

Remove H/PC Explorer 1.x

If you are upgrading from version 1.x, you need to remove H/PC Explorer before you install Windows CE
Services 2.1.

1. Click the Start button, point to Settings, and then click Control Panel.
2. Double-click Add/Remove Programs.
3. Select H/PC Explorer 1.x from the list, and then click Add/Remove.
4. Follow the directions on your screen.

Update Microsoft Exchange

If you are using the version of Microsoft Exchange that came with Windows 95, update Exchange (the
following procedure describes how to determine this).

IMPORTANT: Do not install the update unless you already have Exchange installed. Also, do not install
the update if you have already upgraded to a newer version of Exchange.

To determine your version of Microsoft Exchange

1. On your desktop computer, start Exchange.
2. On the Help menu, click About Microsoft Exchange. In the dialog box, check the version on the first

line.

• If the version is 4.0.410.59, you must install the update. Go to the next procedure.
• If the version is greater than 4.0.410.59, do not install the update. Go to "Installing Microsoft

Schedule+ 7.0a."

To install the Microsoft Exchange Update

___________________________________________________________________________________

WARNING: The U.S. English version of the Microsoft Exchange Update may cause serious problems if
installed on non-U.S. English versions of Windows 95. Installation on any version of Windows 95 except
for the U.S. English version is not supported.

___________________________________________________________________________________

1. Insert the disk labeled "Microsoft Exchange Update Disk 1" into drive A.
2. On the Start menu, click Run.
3. Type a:\setup, and then click OK.

Installing Microsoft Schedule+ 7.0a

Install Microsoft Schedule+ 7.0a if you have:



• No version of Schedule+ or Microsoft Outlook on your desktop computer.
• Schedule+ 1.0 or 7.0 installed (the following procedure describes how to determine this).

To determine your version of Microsoft Schedule+

1. On your desktop computer, start Schedule+.
2. Look at the opening screen. If the version in the lower-right corner of this screen is 7.0a or later, do not

install Schedule+ 7.0a. Instead, go directly to "Installing Microsoft Windows CE Services."

To install Microsoft Schedule+ 7.0a

1. Insert the disk labeled "Microsoft Schedule+ Disk 1" into drive A.
2. On the Start menu, click Run.
3. Type a:\setup, and then click OK.

Installing Microsoft Windows CE Services

To install Microsoft Windows CE Services

1. Insert the disk labeled "Microsoft Windows CE Services Disk 1" into drive A.
2. On the Start menu, click Run.
3. Type a:\setup, and then click OK.

Dial-Up Networking Upgrade on Microsoft Windows 95
You will need to upgrade to version 1.2 of Dial-Up Networking if you have Windows 95 and want to
establish an outbound dial-up network connection (such as a connection to your Internet service provider or
corporate network) while your device is connected to your computer. If you have a TCP/IP stack on your
computer, this upgrade will replace it.  If you have programs that rely on a third-party stack, you may need
to reinstall these programs. For more information, see the Readme file on Disk 1 of this component.

To install Microsoft Windows 95 Dial-Up Networking 1.2 Upgrade

1. Insert the disk labeled "Microsoft Windows 95 Dial-up Networking Upgrade Disk 1" into drive A.
2. On the Start menu, click Run.
3. Type a:\msdun12, and then click OK.
4. If you see a dialog box that asks if you want to keep a newer file, keep the newer file.
5. You will be asked to restart your computer twice during this installation.
6. After you restart your computer, you will see a DHCP error message. Click No if you do not want to

see DHCP error messages in the future.
7. For additional information on the features and known problems with this upgrade, be sure to read the

following sources:

• The Optional Components section.
• The Readme file in the Microsoft Windows 95 Dial-Up Networking Upgrade version 1.2 folder in

Optional Components.
• The files Dial-Up Networking 1.2 Release Notes.doc and About PPTP and Dial-Up Networking

1.2.doc located in your Windows folder by this upgrade.

3.11 REMOVING OR REINSTALLING SCHEDULE+ OR MICROSOFT EXCHANGE UPDATE

If you need to remove or reinstall either Schedule+ 7.0a or the Microsoft Exchange Update from your
computer, you need to use the Setup programs on the CD-ROM that came with your H/PC. Attempting to
do this by using Add/Remove Programs in Control Panel will not work correctly.

To remove or reinstall the Microsoft Exchange Update:



• Insert the Windows CE Services CD-ROM into your CD-ROM drive.
• Click the Start menu, and then click Run.
• Type d:\exupdusa\exupdusa.exe, where d: is the drive letter for your CD-ROM, and press ENTER.
• When the installation program runs, follow the instructions provided. You will be given a number of

options during the setup, including Remove All, which will remove Microsoft Exchange, and
Reinstall, which will reinstall the Microsoft Exchange Update.

To remove or reinstall Schedule+ 7.0a:

• Insert the Windows CE Services CD-ROM into your CD-ROM drive.
• Click the Start menu, and then click Run.
• Type d:\splus70a\disk1\setup.exe, where d: is the drive letter for your CD-ROM, and press ENTER.

• When the installation program runs, follow the instructions provided. You will be given a number of
options during the setup, including Remove All, which will remove Microsoft Schedule+ 7.0a, and
Reinstall, which will reinstall Microsoft Schedule+ 7.0a.

NOTE:  If you installed the program from floppy disks, you will need to run Setup from the floppy disks to
remove or reinstall the program.


